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What Is Setup?

If you make additions or changes to your hardware or software, you need to inform Windows. You can
do so by using Setup.

Setup installs new device drivers for hardware you add and creates program items icons in Program
Manager groups for new applications on your hard drive.

NOTE: If the new hardware is a printer, you use Control Panel from the Main Group to install it.
You can run Setup from within Windows or from outside Windows at your system's MS-DOS prompt.



Setup from Windows

By running Setup within Windows you can:

. Install device drivers that came with Windows 3.0.
- Create program item icons for applications already installed on your hard disk.

Windows supplies program information files (PIFs) for many non-Windows applications. Setup adds
program item icons for non-Windows applications only if they have PIFs. If Setup doesn't create one for
the application you want to add, you can create a PIF yourself using PIF Editor.

Related Procedures



Procedures
Creating New PIFs from Scratch

Installing Windows from Scratch
Setting Up Applications



hint

If you are adding just one Windows application, it's easier to create a program item for it from Program
Manager. If you are adding several Windows applications,or one or more non-Windows applications,
you'll find using Setup faster.



Setup from MS-DOS

By running Setup from MS-DOS you can:
] Install a device driver not supplied with Windows.
] Install an updated version of a device driver that you previously installed.

Some device drivers became available after Windows 3.0 was released.

You can contact Microsoft for a Supplemental Driver Library disk that contains some of the updated
drivers. You can also check with the manufacturer of your device for information.
O Related Procedure
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Change System Settings Command

Options
Change System Settings...
qu"-\fi 'Q:_-st"'\lr‘ T e
Changes settings for your display, keyboard, mouse, and network.

If you change hardware settings with Change System Settings, you must have the appropriate hardware
to support these changes or you might make Windows unusable. Also, Setup will install only those
drivers included with Windows.

If you change system settings, Setup will prompt you to restart Windows so that the changes can take

effect.
] Related Procedure




Set Up Applications Command

Options
Change System Settings...
Set Up Applications...
S e T e ST O R
Sets up the applications already on your hard disk so that they will run smoothly with Windows.

Before you can use the command to set up an application, you must install the application on your hard
disk. Setting up an application makes it run smoothly with Windows.

Setup creates an icon in a Program Manager group for each Windows application and each non-

Windows application you add. However, Setup will add an icon for a non-Windows application only if it

has a program information file (PIF). Setup includes information for many major applications, but not all.

If Setup does not create a PIF for the application you want to add, you can create one using PIF Editor.
. Related Procedures




Procedures

Creating New PIFs from Scratch
Setting Up Applications



Exit Command
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Exits Setup and closes the Setup window.
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Changing System Settings

If you change to a system configuration that is different from the one you had when you installed
Windows, you can use Setup to change your software and hardware settings. For example, you might
want to change from a 16-color VGA display to a 256-color VGA+ display. You must have the
appropriate hardware to support these changes or you might make Windows unusable. Setup lets you
change your display, keyboard, mouse, or network settings. =

Note that you will have to restart Windows or reboot your computer if you change settings using Setup.
For this reason, it is a good idea to close all your running applications before you start Setup to change
settings.

To change your display, keyboard, mouse, or network:

Make sure that your hardware is set up to match the setting you are changing.

Choose Change System Settings from the Options menu.

Click the arrow at the right of the setting that you want to change.

Select the setting that you want.

Click OK.

Insert a diskette or CD-ROM disc if Windows prompts you to do so. Then click OK.

Or type the pathname of the device-driver file. Then click OK.

Choose Exit from the Options menu.

8 Make sure there are no disks in drive except the CD-ROM drive and choose Reboot (if it appears).

Or choose Restart Windows.
Related Procedures
Keyboard Procedure
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Procedures

Installing Windows from Scratch
Running Setup from MS-DOS



hint

The preferred method for changing drivers is to use Control Panel.



Running Setup from MS-DOS

To run Setup from MS-DOS:

1 Exit Windows.
Do not use the DOS Prompt icon in the Main Group window. Using this icon will result in an incorrect
setup.

2 Type setup and press ENTER.
] Related Procedures
] Keyboard Procedure



Procedures

Changing System Settings
Exiting Program Manager (and Windows)
Installing Windows from Scratch



Installing Windows from Scratch

To install Windows from scratch:

1 Exit Windows.

2 Delete the Windows directory and all the files and subdirectories contained in it.

3 Place your Microsoft Windows CD-ROM disc in the CD-ROM drive and switch to that drive.
4 Type setup and press ENTER.

5 Follow the setup instructions on your screen.
Related Procedures
Keyboard Procedure



Procedures

Changing System Settings
Exiting Program Manager (and Windows)
Running Setup from MS-DOS



Setting Up Applications

After you install an application on your system, you can use Setup to make sure it will run smoothly with
Windows. The applications Setup adds this way must already be installed on your hard disk.

You can direct Setup to search:

. All drives (fixed, local, or non-removable)
. One drive
] The current path

Setup creates an icon in a Program Manager group window for each Windows application and each
non-Windows application you add. However, Setup will add an icon for a non-Windows application only
if it has a program information file (PIF). Setup includes information for many major applications, but not
all. If Setup does not create a PIF for the application you want to add, you should create one using PIF
Editor.

If you are adding just one Windows application, it might be easier to use Program Manager. If you are
adding several Windows applications or one or more non-Windows applications, using Setup is the best
method.

To add an application to Windows:

1 Choose Set Up Applications from the Options menu.

2 Click OK to search all your drives for existing applications.
Or select a specific drive to search, and then click OK.

When Setup finishes its search, it displays in the left list box the names of the applications it found.
(The names are taken from the application. They are not supplied by Setup.) You must move each
application that you want to set up from the list box on the left into the list box on the right.

3 Click an application you want to select.

When you select an application, Setup displays the application's pathname in the lower-left corner of
the dialog box. Because more than one application can have the same name, check the pathname to
make sure the application is the one you want. Also, since Setup identifies each application by its
executable name, it may display the wrong name sometimes. (For example, WordPerfect and
MultiMate both use the name WP.EXE.) Check the names of the applications Setup finds to verify that
you actually own those applications.

4 Repeat step 3 to select more than one application.
To cancel a selection, just select it again.
5 Choose Add to move the selected applications to the right list box.
Or choose Add All to move all the listed applications to the right list box.

If you change your mind about adding an application after you add it to the right list box, select the
application and then choose Remove.

6 Click OK once you have added all the applications you want to set up.
. Related Procedure
. Keyboard Procedure
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Keyboard: Changing System Settings

To change your display, keyboard, mouse, or network:

NOoO ok ODN -

(oo}

Make sure that your hardware is set up to match the setting you are changing.

Press ALT and then o.

Press C.

Press TAB until you reach an option you want to change.

Use the UP or DOWN ARROW key to select the setting you want.

Press ENTER.

Insert a diskette or CD-ROM disc if Windows prompts you to do so. Then press ENTER.
Or type the pathname of the device-driver file. Then press ENTER.

Press ALT and then o.

Press X.

Make sure there are no disks in any drive except the CD-ROM drive and choose Reboot (if it
appears).

Or choose Restart Windows.
Related Procedures
Mouse Procedure



Procedures

Installing Windows from Scratch
Running Setup from MS-DOS



Keyboard: Running Setup from MS-DOS

To run Setup from MS-DOS:
1 Exit Windows.
2 Type setup and press ENTER.

Related Procedures
Mouse Procedure
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Changing System Settings
Exiting Program Manager (and Windows)
Installing Windows from Scratch



Keyboard: Installing Windows from Scratch

To install Windows from scratch:

1 Exit Windows.

2 Delete the Windows directory and all the files and subdirectories contained in it.

3 Place your Microsoft Windows CD-ROM disc in the CD-ROM drive and switch to that drive.
4 Type setup and press ENTER.

5 Follow the setup instructions on your screen.
Related Procedures
Mouse Procedure
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Changing System Settings
Exiting Program Manager (and Windows)
Running Setup from MS-DOS



Keyboard: Setting Up Applications

To add an application to Windows:

1
2
3

Press ALT and then o.

Press s.

Press ENTER to search all your drives for existing applications.

Or use the UP ARROW or DOWN ARROW key to select a specific drive to search, and then press ENTER.

Use the UP ARROW or DOWN ARROW key to move the selection cursor to application you want to set up.
Then press the SPACEBAR.

Repeat step 3 to select more than one application.
Press ALT+A to move the selected applications to the right list box.
Or press ALT+D to move all the listed applications to the right list box.

Press ENTER once you have added all the applications you want to set up.
Mouse Procedure






—Windows Setup Keys

To Press

Open a drop-down list box ALT+DOWN ARROW

Select an item in a drop-down list box ALT+UP or DOWN
ARROW

Move from area to area within a dialog TAB

box

Move from area to area in reverse order SHIFT+TAB

Move to the dialog box option whose ALT+Letter
underlined letter matches the one you

type

Move among items in a list box UP or DOWN ARROW
Execute a command button, or choose ENTER

the selected item in a list box and
execute the command

Close the dialog box without completing ESC
the command (same as Cancel)






Setup

Lets you add hardware and software to your Windows environment and modify information about some
current settings. Setup installs new device drivers for hardware you add and creates program item icons
in Program Manager groups for new applications on your hard drive.



application Control-menu

Bestore
Move
Size
Minimize
Maximize

Close

Switch To...

Restores the application windaw ko itz farmer size.
boves the application window to another location,
Changes the size of the application window.

Shrink.g the application window to an icon.

Enlarges the application window ta ite masimunn size.

Clozes the application windov.

Starts "Windaows Tazk List.



title bar = Multimedia Windows Setup u

Contains the title of the application running in the window, in this case Setup.
L Drag the title bar to move the window.



Minimize button E
L Click the Minimize button to shrink the Setup window to an icon.



Options menu

Change System Settings... Changes hardware settings for pour computer spstem,
Set Up Applications... Setz up the applications already on vour hard disk.

Exit Exitz Setup and clozes the Setup window.




Help menu

Index
Keyboard
Commands
Procedures
Using Help

About Windows Setup...

Dizplays an alphabetical list of all Help topics.
Dizplays Help onwWindows Setup key combinations,
Dizplays Help on Windows Setup commands.
Digplayz Help onwWindows Setup procedures.
Digplays infarmation about Windows Help.

Dizplays important information about Windows Setup.



menu bar |thiuns Help |

Contains the names of all the Setup menus.
. Click a menu name to display commands.



Display

Shows the type of display driver you installed to work with Windows.
. Choose Change System Settings from the Options menu to change your display driver.



Keyboard

Shows the type of keyboard driver you installed to work with Windows.
. Choose Change System Settings from the Options menu to change your keyboard driver.



Mouse

Shows the type of mouse driver you installed to work with Windows.
. Choose Change System Settings from the Options menu to change your mouse driver.



Network

Shows the type of network driver you installed to work with Windows.
. Choose Change System Settings from the Options menu to change your network driver.



Swap file

Shows the type and size of swap file you installed with Windows.



application window

The main window for an application, in this case the Setup window. It contains the application's menu
bar and main workspace. The Setup application window displays details about your computer hardware
and software configuration.



application icon Program b anager

Represents a running application. An application icon appears after you minimize an application.
. Double-click an application icon to restore it to a window.



desktop

The background on which windows, icons, and dialog boxes appear.
. Double-click anywhere on the desktop to start Task List.
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386 enhanced mode
active

active printer
animation
application
application icon
application window

arrow keys
associate

AUTOEXEC.BAT
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<< button

>> button

Back button
base-level synthesizer
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baud rate

bitmap

branch

browse

byte
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cascading menu complementary color
CD-ROM compound device
channel CONFIG.SYS

check box Contents button
choose Control menu
Clipboard Control-menu box
close conventional memory
collapse cutout

command

command button
command line



D

data bits Directory Tree window
default button directory window
default printer disk-drive icon
desktop display box

desktop pattern document

destination directory document file

device contention document window
device driver DOS

dialog box drag

directory path drop-down list box

Directory Tree



E

error-checking
expand

expanded memory
extended memory
extended synthesizer

extension



F

file

file information line
flow control

font

font size

format

full-screen application



G
General MIDI Mode standard

rou
group icon
group window



H

History button
hotspot
hue

HyperGuide button bar



|
icon

insertion point
International MID| Association



J

No defined terms.



keymaps
keyword
kilobyte



L

list box
local printer
local queue
luminosity



M

maximize
Maximize button

Media Control Interface

memory
menu

menu bar

menu command
menu name
menu title

MIDI

MIDI file

MIDI Mapper
MIDI sequencer

MIDI Manufacturer's Association (MMA)

minimize

Minimize button
movie file

MSCDEX

multimedia extensions
Multimedia PC

multitaskin



N

network printer
network queue
network server

non-Windows application



O
open
option button



P

parity print option

palette printer-driver file

patch printer font

patchmaps printer queue information line
pathname program file

picture elements program information file (PIF)
pixels program item

playlist program item icon

pointer

port



Q

No defined terms.



R
RGB components

read-only
real mode

Restore button
root directory




sample serial port
saturation shortcut key
scaled font size shrink

screen font simple device
screen saver solid color
scroll arrow source directory
scroll bar spin box

scroll box standard mode
Search button status bar
select stop bits

selection cursor synthesizer



T
Task List
text box
text file
title

title bar
opi
rac

—
(@]

—
~



U
Up button



v

vector font

virtual memory
volume label



W

waveform

WAVE format
wildcard characters
window

window border
Windows application
wrap



X

No defined terms.



Y

No defined terms.



Z

No defined terms.



386 enhanced mode

Provides access to the virtual memory capabilities of the Intel 80386 processor. With virtual memory
capabilities, Windows applications can use more memory than is physically available. Enhanced mode
also allows for multitasking of non-Windows applications.



active

Describes the selected window or icon that you are currently working with. Windows always applies the
next keystroke or command you choose to the active window. If a window is active, it appears in front of
all other windows on the desktop, and its title bar changes color to differentiate it visually from other
windows. If an icon is made active, its Control menu appears.

Inactive is the opposite of active and describes windows or icons on the desktop that are not selected.



active printer

An installed printer that has been assigned to a printer port using Setup or Control Panel. More than one
printer can be set up to work on a single port, but only one can be active, since only one printer can be
physically connected to the port at a time.

An inactive printer is an installed printer that is not currently connected to the printer port.



animation

The display of a series of graphic images, simulating motion. You can play animation files (for example,
files with the.MMM extension) with the Media Player accessory. Animations are also called movies.



application

A computer program used for a particular kind of work, such as word processing. This term is often used
interchangeably with "program.”



application icon Alarm Clock

An icon that represents an application that is running.



application window

The main window for an application. It contains the application's menu bar and main workspace. An
application window may contain multiple document windows.



=g -
arrow keys
The four arrow keys on your computer keyboard. These keys move the cursor or pointer on your screen
to locations you choose. Each arrow key moves the cursor or pointer in the direction of the arrow on the
key. Each arrow key is named for the direction in which arrow points: UP ARROW, DOWN ARROW, LEFT
ARROW, and RIGHT ARROW.



associate

To assign files that have the same extension to a program. When you choose a file with the specified
extension, the associated application runs with the file loaded.



AUTOEXEC.BAT

Batch file that lists MS-DOS commands. MS-DOS automatically carries out the commands in your
AUTOEXEC.BAT file when you turn on your computer. The file is located in the root directory of your first
hard disk, which is usually drive C.

Typically, an AUTOEXEC.BAT file starts memory-resident utilities such as a network and sets up
environment variables that are used later by applications. In addition, your AUTOEXEC.BAT file might
set your MS-DOS prompt or start pop-up programs such as Borland's SideKick.



<< button ILI

Displays the previous topic in a series of topics, until you reach the first topic in the series. Then the
button is dimmed. Use this button when you want to backtrack through topics the way they are
organized in HyperGuide.



>> button ILI

Displays the next topic in a series of topics, until you reach the last topic in the series. Then the button is
dimmed. Use this button to move from topic to topic in the recommended order.



Back button ﬂl

Displays the last topic you viewed. HyperGuide moves back one topic at a time, in the order in which
you viewed them.



base-level synthesizer

One of the two types of synthesizers accommodated by Windows.

MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers
and another version for extended synthesizers. The distinctions between base-level and extended
synthesizers are based on the number of instruments and notes the synthesizer can play.



batch file

Afile that runs a sequence, or "batch," of commands when you type its flename. All filenames of batch
files end with the extension .BAT, even though you don't have to type this extension to run the batch file.



baud rate

Signalling speed measured by the number of signals per second.



bitmap EMEH

An image stored as an array of bits.



L—EDLETTERS
branch

A segment of the Directory Tree, representing a directory and any subdirectories it contains.



browse

To look through files and directories. In some dialog boxes, the Browse button shows a list of files and
directories from which you can choose.



byte

The amount of memory space (normally 8 bits) that a computer needs to represent a single character or
word.



. Scroll
cascading menu |L|

A menu that opens from a command on another menu.



CD-ROM

Compact Disc-Read Only Memory. An optical data-storage technology that allows large quantities of
data (such as animations, images, music, and sound) to be stored on a compact disc similar to discs
used by the music industry.



channel

MIDI uses channels to send messages to individual devices within a MIDI setup. There are 16 MIDI
channel numbers. Devices in a MIDI setup can be directed to respond only to messages marked with a
channel number specific to the device.



check box L]
&

A small square box that appears in dialog boxes and can be selected or cleared. When the check box is
selected, an X appears in the box.



choose

To use key combinations or your mouse to carry out a command in Windows. You often choose a
command after you have selected an item or made it active.



Clipboard IEI

Atemporary storage area in memory, used to transfer information. You can cut or copy information onto
the Clipboard and then paste it into another document or application.



close

To reduce a document window or application window to an icon or, in some cases, to remove it from the
desktop. You close a window by double-clicking the Control-menu box or choosing the Close command
from the Control menu. When closing an application window, you can choose to save or abandon
changes to the current document before you close it.



collapse

To hide a level of directory information in the Directory Tree window. When you first start File Manager,
all directories but the root directory are collapsed.



command L‘_SP"’ A

A word or phrase, usually found in a menu, that you choose to carry out an action.



command button &I

A button in a dialog box that carries out or cancels the selected action. Two common command buttons
are OK and Cancel. The button that carries out the action will often have a label that describes it (for
example, Open, Create, Install). Another dialog box appears when you choose a command followed by
ellipses.



command line

Information given to MS-DOS that specifies a command and all the pertinent information to carry it out.
For example, to start Windows, you type win at the MS-DOS prompt.



complementary color

The color exactly opposite a color on the RGB color wheel. For example, the complementary color of
blue is yellow.



compound device

Devices, such as the waveform audio driver, that have an associated file and require a filename
specification when opened.



CONFIG.SYS

A file that defines device drivers and specifies your MS-DOS configuration. For example, a typical
CONFIG.SYS file might specify the location of the MS-DOS file COMMAND.COM, define an extended
memory manager, and specify how many files an application can have open at once. MS-DOS runs the
commands in the CONFIG.SYS file each time you turn on your computer. Your CONFIG.SYS file is
located in the root directory of your first hard disk, which is usually drive C.



Contents button Contents |

Displays the HyperGuide contents.



Control menu

The menu in the upper-left corner of a window. The Control menu appears on every application that runs
in a window and on some non-Windows applications. Document windows, icons, and some dialog boxes
also have Control menus.

Control menu commands move, change the size of, and close windows. You can also switch to Task List
by using the Control menu. For non-Windows applications, Control menu commands transfer
information and perform other functions, depending on the application.



Control-menu box

The box located in the upper-left corner of a window. Clicking the Control-menu box opens the Control
menu for the window.

b Application Control-menu bos

T Sy

M Document Contral-menu box
F - s

e T i



conventional memory

The first 640K of memory that MS-DOS uses to run applications. Most computers have at least 256K of
conventional memory and can accommodate up to 640K of conventional memory.



cutout ' K

A portion of a Paintbrush drawing you select with the Scissors or Pick tool.



data bits

The bits in each package of data sent between two computers during telecommunication. Most
characters are transmitted in 7 or 8 data bits.



default button |i|

The command button in some dialog boxes that is automatically selected or chosen by Windows as the
most logical or safest choice. The default button has a bold border, indicating that it will be chosen if you
press ENTER. You can override a default button by choosing Cancel or another command button.



default printer

The printer that Windows applications automatically use when you choose the Print command. You can
have only one default printer, which must also be the active printer on the port. The printer you use most
often should be made the default printer.



desktop
The background of your screen, on which windows, icons, and dialog boxes appear.



desktop pattern

A geometric pattern that appears across your desktop. You can design your own pattern or choose one
of the patterns provided by Windows.



destination directory

The directory to which you intend to copy or move one or more files.



device contention

When several applications simultaneously request use of a peripheral device, such as a printer or
modem.

Windows automatically handles device contention when all the applications are Windows applications.
When one of the applications is a non-Windows application, however, the conflict is handled according
to the options you select in the 386 Enhanced dialog box. This dialog box appears when you choose the
386 Enhanced icon in Control Panel.



device driver

Tells Windows how to control a piece of hardware. Using Control Panel, you can install device drivers for
your:

Display (monitor)

Keyboard

Mouse

Network



el N R |
dialog box I [ Draft Quality I

A rectangular box that either requests or provides information. Many dialog boxes present options that
you must choose from before Windows can carry out a command. Some dialog boxes present warnings
or explain why a command can't be completed.



directory path TN T Diirectary path

The directions to a directory or file within your system.

In the illustration, C:\ART stands for the ART directory on drive C. Any commands you use affect the files
and subdirectories in this directory.

When you want to specify a file, make sure the filename follows the directory path.



. “LEayETem
Directory Tree EHORDS
A graphic display of a disk's directory structure. The directories on the disk are shown as branching from
the disk's root directory.



. . | e3voros [
Directory Tree window

A File Manager window that shows the complete branching structure of the selected disk drive.



| =S HE UL L LU IECH PL T LUIL Il

directory window Il =

A File Manager window that lists the contents of a specific directory. The directory window shows all the
files and subdirectories contained in the directory.



|l==1A |[=]C |EEID |EE]E [FET|F

An icon in the Directory Tree window of File Manager that represents a disk drive on your system.
Different icons depict floppy disk drives, hard disk drives, RAM drives, CD-ROM drives, and network disk
drives.

disk-drive icon




display box

A display box is not an option, but a type of text box that shows an example of another option you have
selected, in this case a sample of the 10 pt, underlined, Helvetica font.



document

Whatever you create with an application, including information you enter, edit, view, or save. A document
can be a business report, a spreadsheet, a picture, and so on.



document file s}

Files that are associated with an application. You can start an application and open the associated file by
choosing a document file icon.



I a sample document. Iﬂ I

document window

A window inside an application window. Each document window contains a single document or other
data file. There can be more than one document window inside an application window.



DOS

Disk Operating System, typically known as MS-DOS (Microsoft) or PC-DOS (IBM). This is the underlying
software that must exist for your PC to operate.



drag

A mouse move. You drag a Windows element by pointing to it, holding down the mouse button, and
sliding the mouse from one spot on the surface of your desk to another and releasing the mouse button.



drop-down list box

A list box that opens and closes in dialog boxes.
Before you open a drop-down list box, it looks like this:

{\ International

‘l'\ |u"ited States |£I ::' YWhen pou chok this armow,
3 the lizt b :
P — ¥ e lizt bow opens

After the list box is open, it looks like this:

iﬁ International

United States —j— YWhen you click thiz arow
Sweden the bow clozes.
Switzerland [French)

Switzerland [German]

p

"\ Switzerland [Italian]
§

N

"-._,..f
m

T aiwan
United Kingdom —

Other [:ul;ntr_l,l +
e Wl e e W
NOTE: When the list is longer than the box, scroll bars are provided.

i



error checking

A method for validating transmissions.



expand

To show hidden directory levels in the Directory Tree. With File Manager, you can expand a single
directory level, one branch of the Directory Tree, or all branches at once.



expanded memory

Memory in addition to conventional memory that is available to applications. It is allocated in 16K blocks.
Windows makes use of expanded memory only if the /r switch is used at startup. Windows running in
386 enhanced mode simulates expanded memory for the applications that need it. Windows running in
standard mode or 386 enhanced mode allows applications to use expanded memory, but does not use
expanded memory itself in managing applications.



extended memory

Memory in addition to conventional memory that is not readily accessible to MS-DOS or MS-DOS
applications. Extended memory cannot be used on 8086 and 8088 computers. Windows running in
standard mode or 386 enhanced mode uses extended memory to manage and run applications.



extended synthesizer

One of the two types of synthesizers accommodated by Windows.

MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers
and another version for extended synthesizers. The distinctions between base-level and extended
synthesizers are based on the number of instruments and notes the synthesizer can play.



extension

Part of a file or directory name that appears after a period and provides additional information. It usually

indicates the type of file or directory. For example, program files have default extensions of .COM
or .EXE.

Many applications include a default extension automatically when you save a file the first time. For
example, Notepad adds a .TXT extension to all filenames unless you specify otherwise.



file

A document or application that has been given a name. All documents are stored as files in Wiindows.
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Information specific to each file in a print queue. The information can include these details:
. The file's position in the queue or a printer icon if the file is printing.
] The title of the print job assigned by the application (if your network software supports this).
. What percentage of the file has printed so far.
. The size of the file in kilobytes (if the Print File Size command on the View menu is selected).
. The time and date you sent the file to Print Manager (if the Time/Date Sent command on the View
menu is selected).

If you are connected to a network printer, the printer queue information line shows the network server
connection. Any detailed information the network can provide appears in the message box at the upper-
right corner of the Print Manager window. Networks can provide varying degrees of detailed information.



flow control

The method for controlling the flow of information.
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font “Water WWater Waim Water Water

A graphic design applied to all numerals, symbols, and characters in the alphabet. A font usually comes
in different sizes and provides different styles, such as bold, italic, and underlining for emphasizing text.



font size

The height of a printed character, measured in points. One inch equals 72 points. For example, 12-point

Helv is 12 points high.
Hely

Helw 8 ABCDEFGHIEL
Helv 10 ABCDEFGHIJKL

Helv 12 ABCDEFGHIJKL
Helv 14 ABCDEFGHIJKL

The font and font size you use determine the amount of text that fits on one page.




format

(1) The appearance of text on the pages of a document. (2) To prepare a disk so it can hold information.
Formatting a disk erases all information that was previously on it.



full-screen application

A non-Windows application that uses the entire screen--rather than a window--to run in the Windows
environment.



General MIDI Mode standard

A MIDI specification controlled by the MIDI Manufacturers Association (MMA). The purpose of this
specification is to enable MIDI file authors to create files that sound the same across a variety of
different synthesizers.



group

A collection of applications within Program Manager. Grouping your applications makes them easier to
find.
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group icon

A group window you have reduced to an icon in Program Manager.



group window I I

A window that displays the items in a group within Program Manager. These items can be applications,
files associated with applications, or a combination of both.



History button ml

Displays a list of the HyperGuide topics you have viewed. Use this button to revisit any of the last 40
HyperGuide topics you have viewed. The most recent topic appears first.



hotspot
Text, graphics, or parts of graphics that provide links to other HyperGuide topics or more information
about the current topic.

Whether text or graphics, the pointer changes to the shape of a hand whenever it is over a hotspot. If
you click a hotspot that is linked to another topic, that topic will appear in the HyperGuide window. If the
hotspot is linked to more information, HyperGuide displays the information in a popup window on top of

the HyperGuide window.



hue

The position of a color along the color spectrum.
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HyperGuide button bar

Contains the HyperGuide buttons you use to move among topics and contents screens. It is located
near the top of the HyperGuide window.



icon

A graphic representation of a disk drive, directory, group, application, document, and so on. You can
restore an application icon to a window when you want to use the application.



insertion point |

The place where text will be inserted when you type.The insertion point usually appears as a flashing
vertical bar in an application's window or in a dialog box. The text you type appears to the left of the
insertion point, which moves to the right as you type.



International MIDI Association (IMA)

The non-profit MIDI organization that circulates information about the MIDI specification.



keymaps

Percussion instruments are key-based--each note plays a different percussion instrument. Keymaps
translate MIDI key values to ensure the proper percussion instruments are used to play MIDI files. All
MIDI files for Windows are authored using standard key assignments based on the General MIDI Mode
standard.



keyword

Words in the HyperGuide Search dialog box that are associated with topics. Each application's
documentation has its own keyword list, including the glossary words in HyperGuide. You select from the
list of keywords or type a keyword to see the list of topics associated with that keyword.



kilobyte

The measurement used for the size of a computer's memory, where 1 kilobyte (K) = 1,024 bytes.



list box syzini txt

A box within a dialog box that lists available choices--for example, the list of all available files in a
directory. If all the choices don't fit in the box, there will be a vertical scroll bar to the right of the list box.
In some list boxes, you can select more than one item.




local printer

A printer that is directly connected to your printer by a cable.
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local queue

Lists the files that you directed to any active printer connected to your computer. The computer and
printers are connected locally by a cable.
When Print Manager starts printing on a local printer, its icon appears at the bottom of your screen. If

you restore the icon to a window, you see the print queue for any active printer connected to your
computer. You can use the Print Manager window to check the status of files in the print queue or to

interrupt or cancel a print job.



luminosity

The brightness of the color on a scale from black to white.



maximize

To enlarge a window to its maximum size by using the Maximize button or the Maximize command.



Maximize button E

The small button at the upper-right corner of a window that contains an Up arrow. Mouse users can click
the Maximize button to enlarge a window to its maximum size. Keyboard users can use the Maximize

command on the Control menu.



Media Control Interface (MCI)

A standard control interface for multimedia devices and files. MCI allows a multimedia application to
easily control a variety of multimedia devices and files.



memory

The space in a computer where information is stored while you are working with it. Most PCs have a
small amount of read-only memory (ROM), containing the built-in programs that start the operation of
the computer when it is turned on, and a large amount of random-access memory (RAM) for users'

programs and data.



+ Minimize on Use
menu —

A list of available commands in an application window. Menu names appear in the menu bar near the
top of the window. The Control menu, represented by the Control-menu box at the left end of the title
bar, is common to all Windows applications. You use a command on a menu by selecting the menu
name, then choosing the command you want.



menu bar File Options Window Help ‘

The horizontal bar containing the names of an application's menus. It appears just under the title bar.
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menu command Bast ey

A word or phrase in a menu that you choose to carry out an action, such as copying a file.



menu name

The name for a particular menu that appears in the menu bar and opens a menu when you choose it.



menu title

A word or phrase in the menu bar that identifies a group of commands. Selecting the menu title causes
the title to be highlighted and its menu of commands to appear below it.



MIDI

Musical Instrument Digital Interface. MIDI sets a communications standard for transferring data between
musical instruments and associated devices.



MIDI file

A file format for storing MIDI songs. In Windows, MIDI files have a .MID filename extension.



MIDI Mapper

A Control Panel option that lets you create and edit MIDI setup maps. Windows uses these maps to
translate and redirect MIDI data.



MIDI Sequencer

Software that creates or plays songs stored as MIDI files. When a sequencer plays MIDI files, it sends
MIDI data from the file to a MIDI synthesizer that produces the sounds. Windows provides a MIDI

sequencer to play MIDI files.



MIDI Manufacturer's Association (MMA)

A collective organization composed of MIDI instrument manufacturers and MIDI software companies.
The MMA works with the MIDI Standards Committee to maintain the MIDI specification.



minimize
To reduce a window to an icon using the Minimize button or the Minimize command. The document or
application remains open (or running), and can be the active application or document.



Minimize button ]

The small button at the upper-right corner of a window that contains a Down arrow. Mouse users can
click the Minimize button to reduce a window to an icon. Keyboard users can use the Minimize
command on the Control menu.



movie file

A multimedia data file (for example, a file with the .MMM extension). You can play movie files with the
Media Player accessory. Movie files are also called animations.



MSCDEX

Microsoft Compact Disc Extensions. MSCDEX is software that makes CD-ROM drives appear to DOS
as network drives. You must have MSCDEX installed on your computer for the CD-ROM drive to work.



multimedia extensions

Additional features added to Windows version 3.0 that enable your computer to run animations, play
sound and MIDI files, and display high-quality images.



Multimedia PC

Multimedia personal computer. A multimedia computer satisfies a minimum set of hardware/software
requirements necessary for multimedia computing. The requirements include:

An 80286/386/486 microprocessor running at 10MHz or faster

2MB or more of RAM

30MB or larger hard disk

VGA display

A digital audio subsystem

A CD-ROM drive

Systems software compatible with Microsoft Windows version 3.0 with multimedia extensions



multitasking

The ability of a single computer to perform several tasks simultaneously.

Multitasking makes it possible to print one document while editing another, or to perform lengthy
computations while you work on something else.



network printer

A printer that is accessible to your computer only through a network.



network queue

Lists the files on the network server if you are using a network printer.



network server

A computer on a network that provides a particular service to other computers. For example, a disk
server manages a large file server, and a print server manages a printer.



non-Windows application

An application that was not designed to run in Windows. Generally, non-Windows applications do not
conform to Windows user-interface standards.



open

To display the contents of a directory or file in a window, or to enlarge an icon to a window.



option button O
®

A small round button that appears in a dialog box and is used to select an option. Within a group of
related option buttons, you can select only one button.



palette

Defines the colors used in a bitmap image. Every device independent bitmap (DIB) has an associated
color palette.



parity
The method of detecting errors in data transmission.



patch
A specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as patches.



patchmaps

A patch is a specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as
patches. Patchmaps translate MIDI patch changes to ensure the proper instruments are used to play
MIDI files. All MIDI files for Windows are authored using standard patch assignments based on the
General MIDI Mode standard.



pathname

The directions to a directory or file within your system. For example, C:\WINDOWS3\APPTS\JUNE.CAL
is the pathname of the JUNE.CAL file in the APPTS subdirectory in the WINDOWS3 directory on drive
C.



picture elements

The smallest graphics unit on the screen. Also known as pels.



pixels

The smallest graphic units on the screen. Also known as picture elements (pels).



playlist

A list of compact disc titles and tracks that determines the order in which the tracks on the disc are
played. Playlists are only used in Music Box.

Use the Program button to assign or edit titles, and to change the playlist.



pointer L%

In Windows, the shape of the pointer indicates its function.
L\} For selecting Windows items, scrolling, resizing windows,
and moving windows and dialog boxes with your mouse.
This is the pointer you will see most often.
For choosing a HyperGuide hotspot.
For selecting text with your mouse.

For changing the size of a window with your mouse.

For changing the location or size of a window with your
keyboard.
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For indicating the application is processing your request.

port

A connection on a computer where you plug in a cable that carries data to a device.

LPT ports are parallel ports. COM ports are serial ports. EPT is a port used for certain printers, such as
the IBM Personal Pageprinter. You can use the EPT port only if you have installed a special card in your
computer.

Multimedia PCs also have a port for a MIDI sequencer.



print options

Printer-specific settings such as page orientation--portrait or landscape--or the manner in which paper
feeds through the printer. These options vary from printer to printer.



printer-driver file

A file that gives Windows important information about how to control your printer, including details about
printer features and the printing interface, descriptions of fonts (such as sizes and styles), character
translations, and control sequences the printer uses to achieve various formats. Windows has printer-
driver files for most commonly used printers.



printer font

A series of dots connected by lines that can be scaled to different sizes. Another name for printer fonts is
vector (or stroke) fonts. Plotters typically use vector fonts.



printer queue information line PCL/HP Lazer)et on LPT1 [F'fiﬁtiﬂg]

Indicates the following:
. The name of the printer.
] Where the printer connects to your computer.
. The current status of the printer.



program file B8

A file that contains information that controls an application. In File Manager, each program file is
represented by an icon. You can start the application by choosing the icon. Filenames for program files
can have these extensions: .EXE, .COM, .PIF, and .BAT.



program information file (PIF)

A file that provides important information that Windows needs to run a non-Windows application. PIFs
contain information such as the name of the file, a startup directory, whether the program writes directly
to the screen or to memory, and multitasking options for applications running in 386 enhanced mode.



program item 1

A program file or associated document represented by an icon in Program Manager. The program item
provides the instructions Windows needs to start an application and open a document (if specified) when
you choose the icon.



program item icon %

An icon representing an application you can start or an associated document you can open from a group
in Program Manager. The program item provides the instructions Windows needs to start an application
and open a document (if specified) when you choose the icon.



RGB components

The amount of each of the three primary colors--red, green, and blue--present in a color. Every color and
pattern is made by varying the three primary colors. This is true even in monochrome (black and white)
mode. For instance, white is made by mixing together 255 parts of red, 255 parts of green, and 255
parts of blue. Black, on the other hand, is 0 red, 0 green, and 0 blue.



read-only

Describes a file or CD-ROM disc that can only be opened and read. You cannot edit a read-only file or
CD-ROM disc and save your changes.



real mode

An operating mode that Windows runs in to provide maximum compatibility with versions of Windows
applications released prior to Windows version 3.0. Real mode is the only mode available for computers
with less than 1 MB of extended memory.



Restore button E

The small button at the upper-right corner of a window that contains both an Up arrow and a Down
arrow. The Restore button appears only after you have enlarged a window to its maximum size. Mouse
users can click the Restore button to return the window to its previous size. Keyboard users can use the
Restore command on the Control menu.



root directory

The main directory on a disk. The root directory is created at the first level when you format a disk. The
symbol used to indicate the root directory of a disk is the backslash (\). For example, the root directory
for drive C is noted as C:\.



sample

A piece of waveform data represented by a single numerical value. You convert sound into digital form
by taking samples of the sound at specific time intervals and converting them to numeric values.



saturation

The purity of a hue, moving from gray to the pure color.



scaled font size

A font size that approximates a specified font size for use on the screen. Windows scales larger font
sizes when a size that is available for the printer is not available for the screen. Scaled fonts may look
slightly different from unscaled fonts. When you choose a smaller font size that is available for the printer
but not for the screen, Windows substitutes the correct size from a precision-drawn font that resembles
the selected font as closely as possible.



screen font
A font that duplicates a printer font on your screen.

If you choose a printer font that does not have a corresponding screen font, Windows substitutes a
screen font that closely resembles the printer font. The substitute font duplicates the line lengths and

page breaks of the font you selected.
When you purchase extra fonts from a printer or font manufacturer, ask about the availability of screen
fonts to match.



screen saver

An image or pattern that is shown on your computer screen during periods of inactivity. Screen savers
hide information currently on the screen; by changing patterns they can also save wear on the
electronics in the display.



scroll arrow E

An arrow on either end of a scroll bar that is used to scroll through the contents of a window or list box.
Clicking a scroll arrow moves the contents one line. Holding down a scroll arrow scrolls the contents
continuously.

Scroll arrows also control the playing of media in some applications, such as Media Player and Sound
Recorder.



scroll bar = = =

A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or
list box.

A scroll bar is also used to control playing of media in some applications, such as Media Player and
Sound Recorder.
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scroll box ED:;

The square or rectangular box within a scroll bar that indicates your relative position within a document
or list box. Mouse users can drag the scroll box up or down quickly through long documents.

A scroll box is also used to control playing of media in some applications, such as Media Player and
Sound Recorder.



Search button ml

Displays the keywords you can use to search for topics. Use this button to look for topics related to a
keyword.



select

To mark an item by highlighting it with key combinations or with a mouse. Selecting does not initiate an
action. After selecting an item, you choose the action that affects or involves the item. For example, you
can select text and then choose the Copy command to copy the text onto the Clipboard.



selection cursor

The marking device that shows where you are in a window, menu, or dialog box and what you have
selected. The selection cursor appears as a dotted box around the text in a dialog box option.



serial ports

Ports used by your system, named COM1, COM2, and so on. Serial ports are typically used for
connecting modems, mouse devices, and some kinds of printers.



shortcut key TN )

A key or key combination, available for some commands, that you can press to carry out a command
without first selecting a menu. The shortcut key for a command is listed to the right of the command
name on the menu.



shrink

To reduce a window to an icon using the Minimize button or the Minimize command. The document or
application remains open (or running), and can be the active application or document.



simple device

Devices, such as audio compact-disc players, that don't have an associated file and can be opened
without a filename specification.



solid color

A color directly supported by your display.



source directory

The directory containing the file or files you intend to copy or move.
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A spin box shows one item in a range of possible choices. Clicking the Up or Down arrow to the right of
the entry lets you "spin" through the available choices until your choice appears in the display rectangle.



standard mode

The normal operating mode for running Windows. This mode provides access to extended memory. In
standard mode, you can also switch among non-Windows applications.



||[Drive C: has 3792896 bytes free.

status bar

Aline of information located at the top or bottom of a window. For example, in a directory window the
status bar tells how many files are selected, how much disk space they occupy, and the total number of
files in the directory. In the Directory Tree window, the status bar shows the number of bytes available on
the disk and the total disk capacity. Not all windows have a status bar.



stop bits
The timing unit between characters.
Stop bits are not actually bits; they determine the time between transmitted characters.



synthesizer

An electronic instrument able to make music and sounds by creating its own audio waveforms and
sending them out to an audio system. A synthesizer can play back MIDI files.



Task List

A window that shows all the applications you have running so you can switch among them. You can
open the Task List window by choosing Switch To from the Control Menu or by pressing CTRL+ESC.



text box Filename:

A box within a dialog box where you type the information needed to carry out a command. When the
dialog box appears, the text box may be blank or may contain text.



text file

A file containing only plain text, numbers or symbols. The text in a text file is uniform and does not
contain any formatting, such as bold, underline, or different fonts and font sizes. A text file usually
consists of characters coded from the ASCII character set.

The advantage of a text file is that it can be transferred to almost any text editor or word processor. Also,
MS-DOS and Windows use text files, such as AUTOEXEC.BAT, CONFIG.SYS, and WIN.INI.



title

Another name for a software application written to run on a Multimedia PC.
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The horizontal bar at the top of a window that contains the title of the window or dialog box. On many
windows, the title bar also contains the Control-menu box and Maximize and Minimize buttons.



topic

The level in the HyperGuide hierarchy at which you see information in the main window. This information
can be in the form of a Quick Look graphic, an explanation of a command, a conceptual overview, a

procedure, or a table of keys. Information in pop-up windows and contents screens are not considered
topics.



track

A sequence of sound on a CD disc, which usually corresponds to a song.



Up button &I

Moves up one level in the HyperGuide hierarchy.



vector fonts

A series of dots connected by lines that can be scaled to different sizes.



virtual memory

A memory management system used by Windows running in 386 enhanced mode, which allows
Windows to behave as if there were more memory than is actually present in the sytem. Virtual memory
equals the amount of free RAM plus the amount of disk space allocated to a swap file that Windows
uses to simulate additional RAM.
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volume label Yalume label

The name you give a disk by using the Label command. Disk labels are optional. You see this

information in File Manager only if you assigned a label to your disk. You can change or add a disk label
through File Manager.



WAVE format

Microsoft's format for digitized waveform files. These files have a .WAV extension.



waveform

A sound waveform displays variances in air pressure over time. An audio signal waveform displays
variances in voltage over time.



wildcard characters

Two MS-DOS characters you can substitute for all or part of a file or directory name when you want to
find similarly-named files or want one command to affect a number of files or directories.

An asterisk (*) substitutes for all characters. A question mark (?) substitutes for a single character.
For example, this entry covers all files with a .DOC extension in the current directory:
*.DOC
And this entry covers everything named with FY, three other characters, and the extension .90:
FY?22.90



window

A rectangular area on your screen in which you view an application or document. You can open, close,
and move windows, and change the size of most windows. You can open several windows on the
desktop at the same time and you can shrink windows to icons or enlarge them to fill the entire desktop.
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window border S

The outside edge of a window. You can lengthen or shorten each border. You can also change the width
of the border with Control Panel's Desktop command.



Windows application

An application that was designed for Windows and will not run without Windows. All Windows

applications follow the same conventions for arrangement of menus, style of dialog boxes, use of the
keyboard and mouse, and so on.



wrap

The automatic movement of the insertion point from the end of one line to the beginning of the next line
as you type. When text wraps, you do not need to press ENTER at the end of each line in a paragraph.









